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EDSL Guide for Revit gbXML Files 
 

Introduction 
 

 This guide explains how to create a Revit model in such a way that it will 

create a good gbXML file. Many geometry issues with gbXML files can be corrected 

within Tas but in general the best solution is to correct the issue within the Revit file, 

as this saves on extra work if the gbXML file is used again or if the Revit file is edited 

and a new gbXML is exported. 

 The Revit term “room” will be used throughout, but the rules apply equally to 

“spaces” in Revit MEP. 

 The guide also explains how to identify gbXML issues within the Tas 3D 

modeller, which helps to highlight areas of the Revit file which need work. 

 

 It is recommended that users watch the videos available at 

http://edsl.myzen.co.uk/downloads/misc/Revit gbXML Training Files.zip 

before using this guide. These videos serve as an introduction to the topic of good 

gbXML creation, and this guide is intended for users who have watched the videos. 
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1. Resolving issues within Revit 

 

 This section explains the most commonly encountered issues with Revit 

models which lead to incorrect geometry within the gbXML file, and gives solutions 

in each case. The best way to ensure a good gbXML import from Revit is to have 

these guidelines in mind from the beginning of the project – correcting an existing 

Revit model is much more complicated and time-consuming. 

 

1.1. Geometry 

 

The aim of this section is to ensure that when rooms are applied to the Revit 

model the resulting gbXML will have a complete set of surfaces and all the surfaces 

will have the correct type. 

Ignoring these rules may cause confused and incorrect geometry in the 

gbXML, e.g., missing walls, walls which have no connection to the building, adjacent 

rooms failing to join together, and internal surfaces exposed to the outside air. 

 

1.1.1. Walls made of multiple elements 

 

 
 

 Where two parallel walls are in contact with each other without an intervening 

void (see example above) this will cause an issue once rooms are applied. Each room 

borders a wall but nothing will link the two walls in the gbXML, so although the 

rooms may look joined, they are in fact not. The best solution is to replace the two 

walls with a new element with a thickness equal to the combined thickness of the two 

walls. Making one of the walls non-room-bounding is a quicker solution but not 

always as good. 

 A common variant of this problem is when a room separation line has been 

placed parallel and in contact with a room-bounding wall. In effect this line stops the 

room from touching the wall, and it should be removed. 

Room separation lines should only be used to separate two rooms, and not for 

any other purpose. 
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1.1.2. Overlapping walls 

 

 When two walls overlap it will cause the same issues as the case where two 

parallel walls are in contact, but is not always as easy to spot as the two overlapping 

walls may look like a single element. However, Revit will give a warning if two walls 

overlap, so check the list of warnings for the building, looking out for the message 

“Highlighted walls overlap”. 

 

1.1.3. Floors and ceilings made of multiple elements 

 

 
 

 As with walls, there should be no instances where floors and/or ceilings are 

placed directly in contact with each other. In the case shown by the section above, the 

room is only considered to be in contact with the uppermost floor element, and the 

lowest floor element is disregarded. The best solution here is to replace the two floors 

with a single, thicker element. The quickest solution is to make the top layer non-

room-bounding. 

 Similarly, a floor or roof should never overlap and occupy the same space as 

another floor or roof. 
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1.1.4. Roof and floor footprints 

 

When drawing the building’s roof, bear in mind that any gaps in the roof will 

allow Revit rooms to leak from the building. Try to ensure that the roof footprints are 

sufficient to fully cover the rooms below them. The same principle applies to the 

internal and ground floors. 

 

 
 

 The section above demonstrates that a very small gap in a roof can have a 

large effect on the room beneath it. The room, highlighted in blue, is leaking out 

upwards through the gap between the roof and the wall. If this model was exported to 

a gbXML the room shown would have two large exposed air surfaces. 

 

1.1.5. Exterior elements 

 

 All floor surfaces which are intended to be in contact with the ground must 

have the function “Exterior”. If the same floor type is to be used elsewhere in the 

building, duplicate the floor type before changing its function. 

 Similarly, all walls intended to be in contact with the outside air should have 

function “Exterior”. If the same wall type is used for internal purposes, duplicate it 

before changing its function. 
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1.2. Defining rooms 

 

 The aim of this section is to ensure that all areas of the building are occupied 

by a room, that all rooms are properly contained, and that all rooms link correctly to 

neighbouring rooms or to external elements of the building. 

 Any part of the building which is not occupied by a room will not be exported 

correctly to the gbXML. If a room is prevented in any way from touching the surfaces 

associated with it, the data exported to the gbXML will be incorrect. 

 

1.2.1. Rooms overview 

 

 
 

 Rooms must be applied to all areas of the building. There should be no region 

within the shell of the building that is not filled by a room, including risers, ceiling 

voids, wall voids, floor voids, etc. Any areas not filled by a room will be missing from 

the gbXML file, and neighbouring walls will be marked as an incorrect type in the 

gbXML. 

 

For example, in the picture above we see a riser which does not contain a room. This 

can be remedied in one of three ways: 

1) Make a neighbouring wall non room bounding so the neighbouring room will 

fill this space. 

2) Adjust the limits of a room above or below the vacant area to fill it. 

3) Place a new room in the vacant area. 

 

 Solution 1 is often the best solution if, e.g., two small spaces which neighbour 

each other can be merged together without having a negative impact on the model. 

Solution 2 can be applied when one riser or lift shaft room can be extended to fill the 

whole shaft. Solution 3 is applicable in all cases, and the best solution when neither 

solution 1 or 2 can be used. 
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 Just as the building must be filled with rooms from side to side, it must be 

filled with rooms from top to bottom. Room limit offsets should be extended, where 

necessary, so that the top and bottom of each room is in contact with either another 

room, or a room-bounding element. 

A good rule of thumb is to set the upper limits of rooms to the level of the 

storey above them, and both base and upper limit offsets to zero. If there is no storey 

above (i.e. a roof defines the top of the room), then it is often necessary to extend the 

upper limit offset to reach up to (or beyond) the top face of the roof surface. This 

ensures that the roof will be exported as a single element. 

 

 
 

 In the section above a room protrudes through the roof. The two most likely 

causes are that the roof is not room bounding, or that the option “Areas and Volumes” 

has not been selected in the “Area and Volume Computations” dialog. It is a good 

idea to select this option before attempting to resolve any room bounding issues, to 

avoid confusion. 

 

1.2.2. Room separation lines 

 

 Room separation lines should only be used to separate one room from another. 

For example they could be used to subdivide a large area, or to form a boundary 

between two areas which do not have a wall between them. 

 In all other instances room separation lines should be deleted. 

 Room separation lines should never overlap walls or other room separation 

lines. If they do then this will show up as a warning within Revit, so check that any 

such warnings have been resolved before exporting the model, and look out for the 

messages “Highlighted room separation lines overlap” and “A wall and a room 

separation line overlap”. 

 

1.2.3. Columns 

 

 All columns must be made non-room bounding. Room bounding columns 

create external links within the building, meaning the column surfaces are treated as if 

they were exposed to the outside air. Room-bounding columns can also lead to 

confused geometry being output to the gbXML, such as missing areas. 

 Where columns form part of a wall between two rooms and removing the 

column would cause the rooms to occupy the same area, the wall should be extended 

to fill the gap left by the column. 
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1.2.4. Wall voids 

 

 
 

 There can be no wall voids that do not contain rooms. As an example, see the 

picture above – two existing rooms are separated by two walls with a void between 

them. The geometry would be incorrect if a gbXML was made from this model; the 

two rooms would have no link and their walls would be marked as the wrong type. 

 

Possible solutions: 

 

 
 1. Make one of the walls non-room-bounding.  

 This is one of the quickest solutions, and is best applied in cases where the 

wall void is very small or the wall separates off an area which logically belongs to the 

larger room (e.g. a small storage area, or a thin wall hiding toilet cisterns). In the case 

above it wouldn’t be a very good solution as the wall void is thick, as is the wall itself, 

and making the wall non-room-bounding has increased the floor area of the left-hand 

room significantly. 

 

 
 2. Place a new room between the two walls. 

 This is another quick solution, and is best applied in cases when the wall void 

is wide. For thinner voids (less than about 300mm) it should be avoided. In this case 

the wall void is quite wide and this solution would be reasonable. 
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 3. Replace the two walls with a single wall element. 

 A new wall type is made whose total thickness is equal to the thickness of the 

two walls plus their void. This is then applied in place of the two walls that existed 

here previously. In most cases this is the best solution as it keeps floor areas correct 

and avoids complicating the model with unwanted void rooms. 
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1.2.5. Floor and ceiling voids 

 

 The same principles that apply to walls between two spaces apply to floors 

and ceilings between spaces. 

 

 
 

 In the section above, two rooms, one directly on top of the other, are separated 

by a ceiling and a floor with a void between these two elements. If a gbXML was 

created with the model as it is, the two rooms would not have a link to each other. The 

solutions are the same as the wall void case: 

 

1. Make one of the elements non-room-bounding. This is a quick solution which 

is the best option if one of the elements does not completely separate off a 

sealed region, for example a suspended ceiling which only partially covers the 

room. In most cases this solution should be avoided as it will give incorrect 

room volumes. 

2. Add a new room in the void. In this case a new level has to be created which 

runs between the ceiling and floor. The new room would then be assigned on 

this level. This solution is best for large floor and ceiling voids (more than 

about 500mm). 

3. Replace the floor and the ceiling with a single element. The new element’s 

thickness should equal the combined thickness of the two elements plus the 

thickness of the void. In most cases this is the best solution. 

 

 In all cases, ensure the offsets of the rooms in question (including the void 

room if this option has been used) are correct; their tops and bottoms must reach a 

room bounding element. 
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1.2.6. Checking for roof gaps in Revit 

 

 Small gaps in roofs and floors can have a big impact on the surface geometry 

of the rooms they are supposed to be containing. One quick way to check for gaps in 

the roof of the model is to increase the upper limits of the rooms on the top floor and 

then go to the File → Export → gbXML dialog. 

 

 

 
 

 The images above show an example of a building with a gap in its roof. The 

first image is the building as it appears in the Revit 3D view, and no roof issues are 

immediately obvious here. The second image shows the building in the Export 

gbXML dialog. The blue shaded areas are the rooms, and on the left hand side of the 

image two rooms are sticking out through a thin gap in the roof of the building. The 

footprint of the roof should be extended to prevent this. 
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1.3. Summary 

 

 

1.3.1. Checklist 

 

 Turn on the “Areas and Volumes” option. 

 Make columns non-room-bounding. 

 Assign rooms to all areas, including lifts, risers, and voids. 

 Ensure room limits are sufficient for each room to have a bounding element or 

another room at the top and bottom. (In general, set upper limit to floor 

above.) 

 Remove all room separation lines that do not separate two areas. 

 Ensure that two or more room-bounding walls have not been placed in parallel 

and in contact with each other. Do the same for floors and roofs. 

 Resolve any warnings about overlapping walls and room separation lines. 

 Resolve any issues with overlapping rooms. 

 Change function of external walls and ground floors to “exterior”. 

 Ensure all areas have a floor. 

 Make half-height internal walls non room bounding. If there are different 

rooms on either side of the wall use a room separation line to mark the 

boundary between them. 

 Ensure that roof footprints are sufficient to cover the areas below.  

 Where possible, replace bay windows with windows directly in the main wall. 

 Use the “Automatically Imbed” option to place curtain glazing within walls 

instead of making holes in the wall’s profile. 
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1.3.2. Walls summary 
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Note that these rules apply equally to links between a room and the outside air, as 

they do to links between two rooms. 
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2. Identifying gbXML issues using Tas3D 

 

2.1. The gbXML model 

 

 The image below shows a simple gbXML which has been imported into 

Tas3D, prior to turning the gbXML into a Tas model. At this stage checks can be 

carried out on the model to ensure that the geometry has been exported as required 

into the gbXML – the gbXML does not need to be converted into a T3D before 

analysing for geometry issues. 
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2.1.1. Checking shade surfaces 

 

 On the “Import gbXML File” dialog box, go to the “Display” tab and disable 

the “Shades” checkbox in the “Display Surfaces” section (see below). This will hide 

any surfaces which are not in contact with a room. If any surfaces disappear which are 

supposed to be in contact with rooms (e.g. walls, floors, or roofs), then the gbXML 

file is incorrect. Shades should only appear for surfaces that are not directly part of the 

analysed area but which will be taken into account for the shading calculations, for 

example roof overhangs, external shading devices, or neighbouring buildings. 

 

 
 

 In the image above, hiding the shade surfaces has caused part of the roof to 

disappear – in this case the issue was that the room limits were set too low and they 

didn’t reach the top of the roof. In general, if anything disappears which shouldn’t 

when the shades checkbox is disabled, the solution is to ensure that a room was 

applied to the area and that the room isn’t prevented from reaching the building 

surfaces by e.g. a room separation line or badly defined room limit. 

 Be sure to look underneath the model to inspect the floor surfaces. 
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2.1.2. Air surfaces 

 

 The “Air” checkbox (also in the “Display Surfaces” section of the “Display” 

tab) is used to toggle the display of surfaces which do not have a solid building 

element applied to them. The only cases for which this would be correct are room 

separation lines between neighbouring rooms and for the interface between two 

rooms, one on top of the other, without a floor between them. 

 In the image below, disabling the “Air” checkbox has made the floor vanish – 

in this case the issue is that there isn’t a room-bounding floor on the bottom of the 

building. 

 
 

 Note that the “With Openings” checkbox is disabled. This option toggles the 

display of openings on the surfaces (windows, doors and rooflights). The reason for 

disabling this option is to distinguish between air surfaces that are not displayed and 

surfaces that are not displayed due to the fact that they are windows and doors. 

 Air surface issues often occur at the same time as shade surface issues, the 

reason being that if a room doesn’t reach its wall, for example, the wall will become a 

shade surface and the room will end with an air surface instead of a wall. 

 Air surfaces can be reassigned to a different building element after the Tas 

model has been created, using the Set Wall / Floor / Ceiling Element tool. 

 It is not uncommon, even with a good Revit model, to end up with small air 

surfaces in the gbXML, usually at the corners of walls. These cannot always be 

helped, but exposed air surfaces will be marked as the building element “Air-

exposed” in Tas3D, which can be given an appropriate construction later, e.g. external 

wall. 
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2.1.3. Roof issues 

 

Holes in the building’s roof can be identified easily in the gbXML model. In 

the instance below, the model had a tall lip sticking up from one end of the building. 

Unticking the “shades” tickbox did not make this lip disappear – if it had, this would 

show it was a parapet wall used for shading only but not connected to any room. 

However, the anomaly remained and as further evidence that this geometry is 

incorrect, the building is shown below using the “spaces” option under “gbXML 

Entity”. On the left hand side of the model two rooms can be seen sticking upwards 

above the rest of the building. The reason for this issue is that there is a gap in the roof 

here. The roof footprint should be changed in the Revit model to prevent this. 
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2.1.4. Colour by analysis 

 

 At the bottom of the “Display” tab is a radio-button which toggles between 

colouring the model by the building element type, or by “analysis”.  This refers to the 

surface link type (for example, ground, external, internal, adiabatic, or a link to 

another zone). This option is used to see if the surface is correctly specified.  

 

 
 

 The most common issues related to surface analysis types are ground floors 

which do not link to the ground and external walls marked incorrectly as “internal”. 

The image above shows an example of the latter issue. As before, the windows and 

doors are removed from the graphic for clarity. The surfaces exposed to the outside 

climate are represented by the colour green but the wall facing out of the page is 

coloured yellow.  This indicates that it is incorrectly specified as an internal building 

component. This can be corrected in Revit by changing the wall function to 

“Exterior”. 

 The surface type represented by each colour may be seen by clicking 

“Analysis Colours” in the “View” menu of Tas3D (see below). The user has the 

option to change the colours used. 

 

 



Guide version 1.27  for Tas 9.4.2 

 19 

2.1.5. Looking inside the model 

 

 As not all issues are related to the building envelope, it may be necessary to 

investigate the internal surfaces of the gbXML file. There are two ways to do this. 

 The first method is to use the checkboxes in the “Display Surfaces” section to 

hide certain surface types. For example, the roofs can be hidden to take a look at the 

surfaces below. 

 The second method is to view only a selection of rooms. On the “Zones” tab, 

click the spaces to investigate (hold down the Ctrl key to enable multi-select). After 

this, click the “Display” tab and enable the “Selected spaces” radio-button. In the 

image below, the “Selected spaces” and “Colour by analysis” options are used to 

check surface types for the ground floor offices. 

In the image below the rooms are free of problems. Look out in particular for 

internal surfaces which have been marked as having the “external” type. If these 

occur, return to the Revit model and check the affected surfaces – the cause is 

probably adjacent or overlapping surfaces and/or room separation lines. 
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2.2. Creating a Tas 3D model from the gbXML 

 

 There are two import options available on the import gbXML file dialog box. 

The “attempt creation of 2D Floors” option will attempt to split the model into floors 

and create a model with all the options normally available within the Tas 3D 

modeller. It is strongly recommended that this option is only attempted if no major 

issues were encountered when using the “create 3D model” option. 

 The “create 3D model” option creates a model where the geometry is taken 

directly from the gbXML file rather than being converted into a normal Tas 3D file. 

Some of the modelling options of 3D Tas are unavailable (for example new windows 

cannot be placed and the geometry of imported rooms cannot be changed), but 

building element types, zone assignments, and window types, dimensions, and frames 

can be edited. New geometry can be added to a model imported using the “create 3d 

model” option. For example, external shades can be added to the imported geometry. 

In most cases, “create 3D model” is the best option to use, and it is the option which 

will be discussed in more detail below. 

 In either case an import should only be attempted after all issues identified 

using the methods explained above have been resolved. 

 

2.2.1. Understanding the gbXML import report 

 

 After pressing the import button, it is worth checking the “gbXML Import 

Report” window. In most cases the errors and warnings shown here indicate that a 

problem needs resolving within the Revit model. Note that following the guidelines in 

section 1 of this document can greatly reduce the number of messages here. The 

meanings of the errors and warnings are discussed below: 

 

 

“INFO Space <name> has no geometry to define volume and floor area.” 

 This message appears if a room has not been placed in a properly enclosed 

region in the Revit file. This may be because there is a gap in the building geometry 

or because the room was placed outside the building. 

 

 

“INFO Space <name> has no surface geometry and will not be imported.” 

 This message appears if a room has not been placed in a properly enclosed 

region in the Revit file. This may be because there is a gap in the building geometry 

or because the room was placed outside the building. 
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 “INFO <number> surfaces have been reversed due to inconsistent gbXML data for 

polygon and angles” 

 This message appears when the angle and polygon data in the gbXML file are 

inconsistent. Tas3D assumes that the angles are correct and reverses the polygon to 

match them. Note that this message may appear in the import report even with well-

made Revit models. The problem occurs during the export from Revit to gbXML, but 

as it is corrected automatically in the Tas3D import it should be no cause for concern. 

 

 

“INFO There are <number> surfaces specified as adjacent to a space on both sides – 

they will be “Adiabatic” surfaces unless “Set Exposed” option is used.” 

 This message appears when instead of linking to another room, the ground, or 

the outside air, a surface has a link to the same room on both sides. Tas3D will 

automatically make these surfaces adiabatic, rather than exposing them to the outside 

air. The most common causes of the message are: 

 

 The surface is an internal wall without another room on the other side, either 

because not all areas have rooms assigned, or because the wall has a void or 

touches another parallel wall. 

 The surface is supposed to be an external wall but has the function “interior”. 

 The room has bad limits and this message refers to an air surface at the top or 

bottom of the space. 

 The surface is supposed to be a ground floor but has the function “interior”. 

 A room separation line is preventing the room from reaching a wall. 

  

 This message can also appear in relation to small additional surfaces which 

sometimes appear at the corners of walls. These surfaces, defined within the gbXML 

from Revit, can appear even in well-drawn models and cannot always be corrected. In 

general, when these surfaces are small they will not have a significant effect on the 

simulation of the Tas model. 

As a general rule, small internal adiabatic surfaces will have little impact on 

the building simulation, but in the case of large or external surfaces the best course of 

action is to return to the Revit model and correct the underlying issue. The issue may 

be obvious by simply inspecting the room in question, but if needed the surface can be 

identified in Revit from its code name in the “Export gbXML” dialog with the 

“Analytical Surfaces” option selected. 

Adiabatic surfaces can be changed to exposed surfaces in Tas3D by using the 

“Select Wall” tool to select the affected surface, and selecting “Set Exposed” from the 

right-click options menu. 

 

 

“WARNING Space reference for <name> is not unique – surface adjacencies may be 

incorrect” 

 This message appears when two rooms have identical names, which can lead 

to incorrect surface links in the Tas model. The only way to correct this is to return to 

the Revit model and rename one of the rooms. 
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“ERROR Space <name> has incomplete or inconsistent surface geometry.” 

 This message appears when it seems the gbXML geometry cannot be put 

together to create a sensible room. This happens either because the model was badly 

drawn or because the geometry has become confused during the export from Revit. A 

common cause is that the model contains room-bounding columns. Note that the 

named room may still be present in the imported model, but it may have incorrect 

surfaces, for example two floors instead of a floor and a ceiling. 

 This can also appear if there are thin gaps between surfaces. The user can 

check whether this is the case by using the analysis model errors and warnings dialog 

(see section 2.2.2). In general, when these gaps are small they will not have a 

significant effect on the simulation of the Tas model. 

 

 

 If there appear to be no changes needed to the Revit model but messages still 

appear in the import report, it may be worth attempting an import using the “attempt 

creation of 2D floors” option. This is only recommended for advanced Tas users as it 

may involve locating, identifying, and correcting complicated geometry issues. 

Remember that some messages may still appear for good models, for example in 

cases where Tas has automatically corrected surface orientations. 

 

2.2.2. Analysis model errors and warnings 

 

 After importing a gbXML using the “create 3D model option”, messages 

specific to gbXML files may appear in the “analysis model errors and warnings” 

dialog box in the 3D view. The meanings of the messages are explained below: 

 

 

“INFO – Imported surface has unknown adjacency – exported as Adiabatic” 

These are surfaces whose type wasn’t clearly defined in the gbXML. Many of 

these surfaces are “air” surfaces where Tas3D has automatically filled in gaps in the 

model. Tas3D has made these into adiabatic because if the model has many small 

gaps it is better not to expose these to the outside air. 

In the dialog box the user can see how large each surface is and decide 

whether its analysis type should be changed. Small adiabatic surfaces will have little 

impact on the analysis. An adiabatic surface can be changed into an exposed surface 

by using the “Select Wall” tool to select it, and choosing “Set Exposed” from the 

right-click options menu. 

 

 

“WARNING – Imported Space has gaps between surfaces” 

 As a general rule, small gaps will have little impact on the building simulation, 

but in the case of large gaps the best course of action is to return to the Revit model 

and find the gaps which are preventing the space from being properly enclosed. When 

the warning is selected in the dialog, the gap will be highlighted on the Tas model. 
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“WARNING – Imported Space has surfaces that may have incorrect orientations” 

If this message appears then it indicates that some surface edges do not match 

with the edges of another surface, and as a result it has not been possible to create an 

enclosed space with no gaps in its geometry. This is a result of confused geometry in 

the gbXML file. Room-bounding columns are a common cause of this error. 

To correct this, the user can use the “Select Wall” tool to select the affected 

surface, and choose “Reverse Geometry” from the right-click options menu. To 

attempt the automatic correction of multiple reversed surfaces, use the “Reverse 

Incorrect Orientation Surfaces” option from the “Tools” menu. Another course of 

action is to return to the Revit model and investigate the affected room, but it may not 

be possible to resolve the issue here. 

As a general rule, if an internal wall has an incorrect orientation then this will 

have little impact on the results and can be left as it is, but external surfaces should 

always be corrected. 

 

 

“WARNING – Imported Space has overlapping surfaces” 

 This message means that two or more surfaces related to the same space are 

overlapping. Where overlapping surfaces are small (it may be almost impossible to 

see the overlap), the effect on the analysis will be negligible, but the message can 

indicate a more serious issue, so checking each instance of the warning is 

recommended. 

 Overlapping surfaces cannot be resolved within Tas, so if the warning 

indicates a serious issue it will be necessary to return to the Revit model. 

 

 

“WARNING – Imported Space has overlapping surfaces and also have surfaces that 

need to be reversed” 

 This message indicates that the space has overlapping surfaces and also 

surfaces with incorrect orientations – see above for details of each issue. 

 

“WARNING – Window(s) not contained within wall/roof – this will give incorrect 

results in daylighting calculations” 

 This will not present a problem if no daylighting calculations are to be carried 

out on the model. 

 The probable cause of this issue is that some surfaces are overlapping the 

edges of the window due to the thickness of the building elements. The issue can be 

resolved by editing the window dimensions or by changing the thickness of the 

building element (it might be advisable to create a new building element for this 

purpose and apply it only in the areas which have this problem). 
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2.3. Troubleshooting 

 

Issue: 

 Parts of the building are missing from the imported file. 

Potential solutions: 

 Ensure that there are rooms in all areas of the building, including voids, lift 

shafts, risers, etc., in Revit. 

 Ensure that rooms have appropriate limits in Revit. 

 Check whether room separation lines are preventing rooms from reaching the 

walls in Revit. Separation lines should only be used to form a boundary 

between two rooms and only in cases where there is no other room bounding 

wall between them (see section 1.3.2). 

 

Issue: 

 Surfaces are missing from the imported file. 

Potential solutions: 

 Ensure that nothing has been accidentally hidden in Tas3D – change the 

display to show all areas of the building and all surface types. 

 Ensure that surfaces are room bounding in Revit. 

 Room bounding surfaces that are not in contact with a room will not be 

included in the gbXML unless an export option that includes shade surfaces is 

chosen in Revit. 

 Shading features in the Revit model will not be included in the exported 

gbXML regardless of export option. Add these in Tas3D instead. 

 Ensure that the surface exists in the Revit file. Floors are sometimes left out by 

Revit users. 

 In rare cases with floors and roofs it may be necessary to extend the limits 

further in Revit (so that the room would extend outside the building if the floor 

or roof was not present, or in the case of internal floors the two neighbouring 

rooms would overlap if not for the intervening floor). 

 

Issue: 

 A roof, floor, or wall has come into Tas3D as a shade surface. 

Potential solutions: 

 In some cases this behaviour is correct, for example for an overhanging roof or 

a roof parapet wall. 

 Ensure that there is a room applied in this part of the Revit model. 

 If hiding the shade surface reveals a non-air surface behind then two surfaces 

may have been placed in contact with each other in Revit (see sections 1.1.2 

and 1.1.3). 

 For a roof or floor, ensure that the room limits are sufficient to reach the 

surface in Revit. For roofs it may be necessary to extend the room limits to 

reach the top face of the roof (or even extend above it). 

 For a wall, ensure that there isn’t a room separation line preventing the room 

from touching the surface in Revit. 
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Issue: 

 A roof has come into Tas3D as two surfaces – a shade surface above and a 

roof surface beneath. 

Potential solutions: 

 Ensure that in the Revit model there is only one room-bounding roof here, and 

not two or more (see section 1.1.3). 

 Extend the room limits to reach the top face of the roof (or extend above it).  

 

Issue: 

A surface that should be exposed to the air has been marked in Tas3D as being 

in contact with the ground, or vice versa. 

Potential solutions: 

 Change the building element type in Tas3D. 

 Adjust the ground plane level in the Revit file. 

 

Issue: 

 A surface that should be exposed to the air or in contact with the ground has 

been marked as “adiabatic” (may appear as “internal” rather than “adiabatic” before 

the gbXML is converted into a Tas3D file). 

Potential solutions: 

 Change the surface type in Tas3D by right-clicking on it and selecting “Set 

Exposed”. To make the surface link to the ground, change the building 

element type in Tas3D. 

 Change the function of the surface to “Exterior” in Revit. 

 

Issue: 

 A surface that should form a link between two rooms is marked as “adiabatic” 

or exposed to the outside air. 

Potential solutions: 

 Ensure that rooms are applied to both areas in the Revit model. 

 Ensure that there is only one surface separating the two rooms in the Revit 

model, rather than two elements. 

 For walls ensure that there are no room separation lines in Revit preventing 

the rooms from meeting (see section 1.3.2). 

 For internal floors ensure that the limits of each room have been set correctly 

in Revit and are sufficient to reach the floor. 

 In rare cases with internal floors it may be necessary to extend the limits 

further in Revit (so that the rooms would overlap if not for the intervening 

floor). 

 

Issue: 

 Rooms extend upwards past the expected limit of the building rather than stop 

at the roof. 

Potential solutions: 

 Ensure the “Areas and Volumes” option is used in Revit. 

 Ensure that the roof is room bounding in Revit. 

 Check for shaft openings in the Revit model. 

 Check the footprint of the roof in Revit to see if there are any gaps. 

 Extend the footprint of the roof in Revit to completely cover the areas below. 
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Issue: 

Windows do not look as expected in Tas3D. 

Potential solutions: 

 For bay windows, replace the bay in Revit with a window placed directly into 

the wall. 

 For curtain glazing, use the “Automatically Imbed” option in Revit to place 

glazing within a wall. 

 Use “Complex” export option from Revit rather than “Simple”.  

 Windows will not be exported to the gbXML if they are below the ground 

plane in Revit. Lowering the ground plane in Revit may result in surfaces 

being marked as exposed to the outside air which should link to the ground. 

This can be resolved by changing the building element type in Tas3D. 

 Use the “break up” option on stacked walls. 

 

Issue: 
 Unexpected holes in floors, ceilings, or roofs. 

Potential solutions: 

 Ensure that there are no room bounding columns in the Revit model. 

 Check the footprint of the surface in Revit to see if there are any gaps. 

 Check for shaft openings in the Revit model. 

 

Issue: 

 External surface appears grey in Tas3D instead of its proper colour. 

Potential solutions: 

 Right click on surface in Tas3D and select “Reverse Geometry”. 

 Select the option “Reverse Incorrect Orientation Surfaces” from the “Tools” 

menu. 

 

Issue: 

 After exporting to TBD, there are one or more zones with zero floor area. 

Potential solutions: 

 In the Tas3D model, select the option “Reverse Incorrect Orientation 

Surfaces” from the “Tools” menu. 

 Ensure that these zones have a floor surface in the 3D model. 

 Manually correct the orientation of the floor surface. Right click on the floor 

surface in Tas3D and select “Reverse Geometry”. 

 

Issue: 

 A room separation line in Revit has come through as an internal wall in Tas. 

Potential solutions: 

 This may be caused by a short wall parallel to the room separation line in the 

Revit model. 

 Check that the upper and lower limits of the Revit walls in this area are 

correct. Are any walls breaking through internal floors from other storeys? 

 Change the wall’s building element to “Null” in Tas3D. 


